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Goat Pedigree 2000
User Manual

INTRODUCTION

Goat Pedigree 2000 conforms to standard Microsoft Windows conventions and is
rather intuitive in operation.  This User Manual assumes that the user is familiar with
the basic use and operation of Windows programs and only addresses the unique or
non-intuitive aspects of the program.

The program is designed for Windows 95 or 98.  It should work on Windows ME or
Windows NT, but it has only been tested on Windows 98.

LEGAL STUFF

Goat Pedigree 2000 is Copyrighted by L.R. Marker, 2000 with all rights reserved.  The
program and its documentation are provided as is and no warranty of merchantability
or fitness of use is expressed or implied.  While the basic kernel of the program has
been in use for several years and is believed to produce correct pedigrees (given that
correct data has been entered in the database by the user), the user should verify that
the pedigrees produced by this program are correct before relying on them for any
legal or advertising purposes.

ORGANIZATION

This manual is organized in three chapters.

• Chapter 1. Installation -- Provides the instructions for installing and
uninstalling the program and its database.

• Chapter 2. Program Basics -- Provides an overview of the menu commands
and other basic operational elements of the program.  This provides a brief
reference manual for the program.

• Chapter 3. Using the Program -- Provides a description of the common tasks
of entering data, creating pedigrees, making database backups, and other
miscellaneous activities.

SUPPORT

Please report problems or suggested future enhancements to lrmarker@bellsouth.net.
If you have difficulty with installation or operation of the program, contact me at the
above email address and I'll get back to you as soon as possible.
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1. INSTALLATION

INSTALLING THE PROGRAM

Before attempting to install Goat Pedigree 2000, it is strongly recommended that all
other programs be closed.  In particular, close all virus scanners or other programs
that may be running in the background.

The program is installed from a distribution CD.  If the setup program does not
automatically start when the CD is inserted in your CD drive, double click on the My
Computer icon, double click on the icon for your CD drive, and then double click on
the icon for SETUP.EXE.

Once Setup starts, the you will be presented with a screen to choose where to install
the program.  You can accept the default location suggested by the program, or choose
an alternate location.

Setup will next provide a screen to choose where to install the database file.  Again,
you can accept the default location or specify an alternate location.  It is recommended
that you do not install the database file in the same folder as the program.  While it
will work quite well if you do, it is easier to make safety backups of the database file if
it is kept in its own unique folder.

Finally, Setup will propose a Start Menu group for the program which you can accept
or you can choose an alternate.

The final Setup screen shows the choices you have made and clicking Next will install
the program.

NOTE -- the first time the Goat Pedigree 2000 program is run after installation, you
will be presented with the screen shown below asking for the location of the database.
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If it is not already pointing to the database folder, change the drive and folder as
required to locate the folder where you installed the database.  Select the database file
which is named GoatDatabase.FFD.  After this first time, the database will be opened
automatically and you will not have to select it again, unless you choose to open a
different database file as discussed later.

UNINSTALLING THE PROGRAM

If for some reason you choose to uninstall the program, double click the My Computer
icon, double click Control Panel icon, double click Add/Remove Programs icon, choose
Goat Pedigree 2000, and click the Remove button.

WARNING -- If the database is still located in the folder where it was first installed
during program installation, the Uninstall procedure above will also delete your
database.  If you want to uninstall the program but want to keep the database, make a
copy of the database and save it somewhere other than in the original database folder
BEFORE uninstalling the program.  (The easiest way to do this is to use the built in
Backup capability of the program as described later.)

Note -- Installing Goat Pedigree 2000 does not make any changes to the Windows
Registry nor to any of the system .INI files.  Therefore, it can be manually deleted by
simply deleting the program folder, data folder, and the program entry in the Start
Menu folder.  (This will leave the program name orphaned in the Add/Remove control
panel, however.)

OTHER FILES ON THE CD

Other files included on the distribution CD include this User Manual in PDF format.
To read or print this file, you need a copy of Adobe Acrobat Reader which can be
downloaded from www.adobe.com.

There is also a database template on the CD which can be used to create a new
database.  This is file TEMPLATE.ZIP.  Copy this file to a folder of your choice on your
hard drive and unzip it.  This will produce a file named NEW.FFD.  Rename this file to
whatever name you choose for your new database, but be sure to keep the .FFD
extension.  Move this file to wherever you want the database to be stored.  Next time
the Goat Pedigree 2000 program is run, choose this file using the File|Open menu
command, and it will become the new default database.  If you need a program to
unzip files, I recommend WinZip which can be downloaded from www.winzip.com.
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2. PROGRAM BASICS

MAIN WINDOW

The main program window of Goat Pedigree 2000 is shown in the figure below.  It
contains a menu bar at the top; below the menu is an optional speedbar.  Below the
speedbar is a database Search Tool.  Below the Search Tool is a Browser window that
displays a number of database records.  Finally, at the bottom is a status line.  The
status line has two parts -- on the left is an area where program hints are displayed.
When the mouse is held over a menu item or a button, a help hint is displayed in the
left pane of the status line.  In the right pane, you will find the number of records in
the current database displayed.

MENUS

The menu options are described here briefly.  It is recommended that you fully explore
each of the menu items to familiarize yourself with the capabilities of the program.
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File Menu

The File menu contains items Open, Backup, Print Setup, and Exit.  Open presents a
standard dialog for selecting a file to open.  The program prompts for the database file
the first time it is run as was described in Chapter 1.  After that, the same database
file is opened automatically whenever the program is run.  Hence, you will probably
never need to use the Open command, but it is there in case you choose to move the
database to a different location or want to open a different database.

Backup has two submenu items, Create backup file and Restore from backup.  These
allow you to make a backup of the database file or to restore the database from a
previous backup.  Note that the Create option only allows you to pick a location where
the backup file will be saved.  A backup file is always saved with the name
FFBackup.FFD.  If you want to save multiple backups, you will need to pick a different
folder for each.  Restoring a backup will always overwrite the currently open database
with the backup.  The restored database will have the name of the currently open
database.  If your database becomes accidentally deleted or corrupted so that it
cannot be opened, create a new database as described in Chapter 1 under Other Files
On the CD, open that new file, and then perform the restore.

Print Setup allows you to select and configure your printer and Exit closes the
program.

Pedigree Menu

The Pedigree menu contains the major program actions.  It contains Browser, Input
Data, Find a Record, View Pedigree, and What If items.

Browser is a toggle control to turn the browser pane in the main program window on
and off.  When it is "on", there will be a check mark next to the menu item.  You will
probably never use this, but it's there if you want it.

Input Data calls up the data entry form that allows you to create a new record in the
data base.  The use of the data entry form will be described later.

Find a Record brings up a form for you to enter the name of a goat.  Once you enter
the name and click OK, the program will search the database for a goat by that name
and if found it will bring up the data entry form for that goat so that you can edit the
data there if you choose.  Note -- the search is not case sensitive, so you don't have to
worry about capitalizing the name correctly to do a search.  It must, however, be
spelled exactly correctly.

View Pedigree asks for a name and then displays the pedigree for the goat whose
name you entered.  Again, the search for the pedigree is not case sensitive.  However,
unlike the Find a Record, View Pedigree tries to locate the record with the name
closest to the one you entered.  If you enter just the first part of the name, the first
record that begins with that string of characters will be displayed.
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What If allows you to create a pedigree without saving it in the database.  This is
useful for creating a pedigree for a potential breeding to see what it would look like.
When you select What If, you will be presented with a special form to enter the name
you want to give to this "what if" animal, and the name of the sire and dam.

If the sire and dam that you name are in the database, when you click the View
Pedigree button, you will get a complete pedigree for the "what if" animal.  That
pedigree can be printed, but it will not be saved.  If you want to create such a pedigree
and save it, then use the Input Data menu to create a permanent record for the "what
if" animal.

Options Menu

The Options menu allows you to customize the program to your liking.  It allows
control of Browser Preferences, Pedigree Formats, Organization Data, and General
Preferences.  The best way to really understand these options is to experiment with
them to see the effect.  Be sure to make a note of the original settings so that you can
restore the program to the way it was (assuming you liked the way it was.)  If you get
the options "messed up" and don't remember what the original settings were, the
factory defaults for the various options are provided in the descriptions that follow.

Browser Preferences allows you to customize how the Browser pane in the main
program window looks.  You can change the width of the columns and choose the font
used to display the text in the Browser pane.  (Factory defaults are Width: 200 pixels,
and Font: MS Sans Serif Bold 10 pt Black.)

Pedigree Formats allows you to control how pedigrees are displayed on the screen
and how they look when printed.  The Pedigree Formats form has three pages selected
by tabs at the top.
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The first tab elects the format for pedigrees displayed on the screen.

Note that you can select the font for the names that are displayed and also you can
choose the font for the comments and annotations.  Experiment with these to see the
effects that changing the various options produce.  (The factory default Screen
Pedigree Font is Fixedsys Regular 9 pt Black Underlined.  You will probably find that a
fixed pitch font produces better looking pedigree displays.  The factory default for the
Comments and Annotations Font is Times New Roman Italic 9 pt Purple.  The factory
defaults for the other selections are as shown in the figure above.)

The second tab controls the format of printed pedigrees and is similar to the screen
format form.

(The factory default Printed Pedigree Font is Bookman Old Style Regular 10 pt Black.
The default font for Comments and Annotations is Arial Italic 8 pt Navy.  The factory
defaults for the other selections are shown in the figure above.)
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The third tab allows you to set the margins and orientation for the printed pedigrees.

This form is self explanatory.  The factory default settings are as shown in the figure
above.

Organization Data brings up a form to define the data that is printed in the upper
left corner of printed pedigrees.  This is normally a farm name and address, but can be
whatever you want printed there.
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At the top of the form are fields for the Name, address, etc.  At the bottom of the form
is a preview window that shows how the organization data will be printed.  Note, as
with any windows program, differences between the screen resolution and the
resolution of your printer may cause slight differences between the way the data looks
in the preview window and the printed page.  Use the preview window as the
preliminary guide, but be sure to make a test print to verify that it looks like you want.

The font for the Name portion of the organization data and the font for the rest of the
data are separately adjustable.  The default Name Font is Bookman Old Style Bold 18
pt Navy, and the default for the Address Font is Bookman Old Style Bold 10 pt Navy.
Note that if you do not have the Bookman Old Style font installed on your computer,
the font that Windows will substitute may cause the print of the organization data to
be poorly formatted.  This can be corrected by choosing a more appropriate font.

At the right edge of the preview window, there are two sets of up/down arrow controls.
These adjust the spacing between the lines of the printed organization data.  The
upper pair control the spacing between the first and second lines, and the lower pair
control the spacing between the second and third lines.

Note that in the sample shown above, there is a fax number included on the phone
number line.  It doesn't show in the entry field on the form, but can be seen by
clicking in the field and then using the right arrow key on the keyboard to get to the
fax number.

General Preferences brings up a form to set miscellaneous program controls.

Enter key same as Tab is used in the Data Entry form.  If this box is checked, then
hitting the Enter key will cause the active field on the form to advance to the next data
field like the Tab key does.  If this box is unchecked, the Enter key will cause the
default button (usually the Save button) to be selected.
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Confirm record changes and Confirm deletes cause a "Are you sure" confirmation to
appear whenever a record is changed/deleted.

Hide Speedbar and Flat Speedbuttons control the appearance of the speedbar that
appears below the menu bar.

Prompt for backup, if checked, will cause the program to prompt you to make a backup
when the program is closed and the number of changes since the last backup equals
or exceeds the number set in the Number of changes control.  If this box is not
checked, this feature will be turned off.  (The number of changes since last backup will
still be tracked, however.)

SPEEDBAR

Below the menu bar is a speedbar with five speedbuttons to simplify selecting the
most common functions.

The first button calls up the Input Data form.  This is the same as selecting the Input
Data item of the Pedigree menu.

The second button calls up the Find a Record form to search the database.  This is the
same as the Find a Record item of the Pedigree menu.

The third button calls up the View a Pedigree form and is the same as the View a
Pedigree item of the Pedigree menu.

The fourth button calls up the What If entry form and is the same as the What If item
of the Pedigree menu.

At the far right is a Backup button.  This button activates the Create Backup function
and is the same as the Create Backup item of the File menu.

SEARCH TOOL

Below the speedbar is the database Search Tool which will search the database for a
specific goat, dam, or sire.
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To use the Search Tool, type a name in the edit field and click the appropriate button.
The Goat button will search for a goat with the name you entered.  The Sire or Dam
button will search for a goat with a Sire/Dam with the name you entered.

Using the Sire or Dam button together with the sorting capability described in the
Browser section below will find all goats with a particular Sire (or Dam).

Note -- the action of the Search Tool is different from that of the Find a Record button
or menu item.  The Search Tool does not call up the data edit form for the goat.
Instead, it locates the goat on the Browser window and scrolls the Browser so that the
selected name appears in the center of the Browser window if possible.

BROWSER WINDOW

The Browser window displays a number of records in the database.  In addition to the
display of the Name, Sire, and Dam for each record, the Browser provides access to a
number of capabilities.

First, by clicking on the button at the top of a column of the Browser, the display will
be sorted by that column.  For example, clicking on the Sire button at the top of the
middle column will sort the display so that the sires appear in alphabetical order.  If
the Search Tool was used to locate a specific sire and then the Sire button is clicked to
sort by sire, then all of the goats with that sire will be listed consecutively.  Note that
this does not change the database, but only affects the Browser display.
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Double clicking on a name will call up the pedigree display for that goat.  This is often
the fastest way to display a pedigree -- locate the desired goat by either scrolling the
Browser display or by use of the Search Tool and then double click the name.

Right-clicking a name brings up a context menu with three choices.

• Edit the data for this goat calls up the Input Data form to allow the record for
this goat to be edited.

• Display pedigree for this goat calls up the Pedigree Display for this goat (same
as double clicking the name).

• Delete data for this goat deletes the record for the goat from the database.  This
is the most common way to delete a record.

Note that double clicking or right-clicking a name in the Sire or Dam column causes
the action to be taken on the name that is clicked -- not the name in the first column.

INPUT DATA FORM

Data is added to the database using the Pedigree Data form which can be called up
using the Input Data item of the Pedigree menu, by clicking the Input Data
speedbutton, or by double clicking a blank space on the pedigree form (discussed
later).  This same form is used to edit existing records in the database.
Most of the fields on this form are self-explanatory, but a few need some discussion.
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The Titles area contains three fields, Title, Classification, and Milk Rating.  The text
entered in the Title field will appear in front of the goat's name with a space between
the title and the name.  You can enter anything here you like up to 10 characters.

Classification will optionally be appended to the name if the associated box is checked.
This may have to be omitted to keep the resulting name under the allowed 30
character limit.  (The program does NOT check to see if this limit is exceeded.)  You
can enter anything here you choose up to 10 characters.

The Milk Rating will be added to the end of the name (following the AGS Classification,
if present).  You can enter up to 6 characters in this field.

It is strongly recommended that you use the applicable titles fields rather
than enter the titles as part of the name.  That way, if an animal gains a title
(or you become aware of the title) after the record has been entered and
used in the pedigrees of other animals, you can edit the one record and it
will be automatically updated for all pedigrees in which it appears.  If you
were to edit the name of the goat instead, then you have created a different
name, and all references to the old name will not get updated to point to the
new entry.

Date of Birth should be entered with four digits for the year.  If you only enter two, the
program will assume the 21st century -- e.g., "98" will be interpreted as "2098".

The size of the comments field is basically unlimited.  This is an ideal place to make a
note of show results, milking test records, and similar information.  The first few lines
of the comments are printed on pedigrees (see the Pedigree Format Option menu item.)
By planning ahead when entering data in the comments field, you can control what
and how this data will appear on printed pedigrees.

Any field can be left blank except the name field.

The functions of the five buttons at the bottom are the following.

• Pedigree will first save the record and then will display the pedigree for this
goat.

• Print will print a copy of the total record for this goat.  Print does not save the
record.

• Delete will delete this record from the database.  This has no meaning on a new
entry and is only meaningful when editing an existing record.

• Cancel will discard the data and close the entry form without saving the data.

• Save will save the record and clear the form, but the form will stay open so that
another record can be easily entered.  When you are finished entering data,
close the form with the Cancel button.
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PEDIGREE DISPLAY FORM

The Pedigree Display window appears whenever the View Pedigree menu item is
selected, the View Pedigree speedbutton is clicked, or the Pedigree button is clicked on
the Data Input form.

This window contains a menu bar, a speedbar, and a pedigree display window.

MENUS

Pedigree Menu

The Pedigree menu provides the following functions:

• Return to Previous Pedigree (discussed later).

• Print Setup calls up the standard Windows Print Setup dialog.

• Print prints the currently displayed pedigree

• Exit Pedigree Display closes the Pedigree Display window and returns to the
Main program window.
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Options Menu

The Options menu provides two options:  Pedigree Formats and Organization Data.
These are the same as the similarly named options described for the Options menu on
the Main program window discussed earlier.  Note -- the Pedigree Format option is
included here primarily to allow you to change the format of Printed Pedigrees from
the Pedigree Display window.  If you change the format of Screen Pedigrees, the
changes will not take place until the Pedigree Display window is closed and reopened.

SPEEDBAR

Below the menu bar is a speedbar with three speedbuttons.

The first button closes the window.  This is the same as the Exit item under the
Pedigree menu.

The second button prints the currently displayed pedigree.  This is the same as the
Print item under the Pedigree menu.

The third button is a Return to Previous Pedigree button which performs the same
function as the Return to Previous Pedigree item under the Pedigree menu.  The use of
this function will be discussed later.

PEDIGREE DISPLAY WINDOW

The main portion of the pedigree display form is the large window where the pedigree
is displayed.   In addition to displaying the pedigree, this window offers several editing
capabilities.

Right-clicking on a name in the displayed pedigree brings up a context menu with six
items.

• Display pedigree for this goat causes the display to show the pedigree for
that goat with that goat's name in the left-most position.  This is particularly
useful in a large pedigree where part of it would be off screen in the current
view.

• Edit data for this goat brings up the Input Data form for this goat.

• Delete record for this goat deletes the record from the database for this goat.
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• Return to previous pedigree undoes the change caused by "Display pedigree
for this goat" by returning to the original pedigree.  Note -- only one level of
undo is available.

• Print pedigree prints the currently displayed pedigree.  It does not matter
which name is selected when this item is chosen, the entire pedigree is printed.

• Exit to main window closes the Pedigree Display window and returns to the
program main window.

One final capability of the Pedigree Display is it's most powerful:  double clicking on a
name will bring up the Input Data form for that goat.  This is the simplest way to
quickly enter an entire pedigree.  The process for doing this will be described in the
next chapter on Using the Program.
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3. USING THE PROGRAM

This chapter describes the major activities that you will perform with the Goat
Pedigree 2000 program and offers a few tips and suggestions to make these tasks
easier.  The topics covered include entering data, editing data already in the database,
creating a pedigree, and backing up your data.

Entering Data

When entering data for a goat, say from a sale catalog page or an advertisement, you
use the Input Data command to bring up the data entry form.  Enter all the data that
you know for the goat such as sire, dam, color, date of birth, etc.  Leave any data you
don't know blank.  If the goat has titles such as MCH or milk titles such as 3*D or
AGS titles such as E, be sure to enter them in the appropriate fields provided and do
NOT enter them as part of the name.  The program will automatically append them to
the name in the right place when you print a pedigree.

Similarly, when you enter the name of a sire or a dam in the data record for a goat,
omit the titles and just enter the name.  Later, when you enter a record for the sire or
the dam you can enter the titles in that goat's record.  By doing this consistently, the
pedigrees will always "link up" correctly even when you later edit a record to add or
change a title.

The easy way to enter data in the data entry form is to use the Tab key or the Enter
key (if Enter Same As Tab option has been selected in General Preferences) to move
from field to field for the text fields.  Then use the mouse to click on the various
buttons to choose ear type, horn type, etc.

Editing Data

Editing data for a goat that is already in the database is pretty straightforward.
Editing is done using the same data entry form used in the original data entry.  The
form will be displayed with the existing data fields filled in.  You can simply add the
new data or correct the existing data and click either the Save or the Pedigree button
to save the data.  The new revised record will replace the old one.

The one possible surprise is that if you change the name of the goat as part of your
edit,  the record is not replaced, but a new one is created instead.  If you intended to
replace the original, then you need to delete the old one after the new one is saved.  If
you clicked the Save button (rather than the Pedigree button), you will be returned to
the Browser window with the old record selected which makes it easy to delete it.  This
is not a bug, but is an intentional feature.  This allows you to rapidly create several
records that have similar data.  For example, if you are entering records for two kids
from the same litter, you can enter the first one and save it.  Then edit that record and
change the name to the second kid.  Also change any other data as required (color,
registration number, etc.) but the sire and dam will already be there and will not have
to be re-entered.  When you click the Save button, you will have both records.
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Creating a Pedigree

Once you "get the hang of it", entering a pedigree is very quick and easy.  It takes
longer to explain it than it takes to do it.

First, use the Input Data function to bring up the data entry form and enter the data
for the goat whose pedigree you are entering as described above.  I will refer to this
goat as the G0 goat (zeroth generation) for simplicity.  Enter all of G0's data that you
know, but in particular we need the sire and dam names entered.  Once you have
entered the data, click the Pedigree button at the bottom of the form.

You will now see the Pedigree Display for G0 and the sire and dam will be filled in.  If
these goats are not yet in the database, that is all you will see.  Next, double click the
sire's name (I will call him G11 for the 1st goat in the 1st generation) and you will be
returned to the data entry form.  The form will already have G11's name filled in, the
sex will already be correctly chosen as Buck, and the cursor will be set in the field for
G11's sire's name.  Fill in what you know about G11 and click Save.  Repeat this for
G0's dam (G12) and again you will be returned to the data entry form with G12's name
filled in and the sex set to Doe.  Continue this process until you either run out of
information to enter or you hit a name that is already in the data base.  When the
latter happens, when you click the Save button you will see the pedigree filled in with
the information that is already there.

When you get to the last generation that you have data for, you do not need to create a
record for the very last goat on each branch of the pedigree tree unless that goat has
titles.  If (s)he has no titles, you can create a record or not as you choose; the printed
pedigree will be the same.  If the goat does have a title, then you need to create a
record for that goat so that you can enter the titles for it.

If the pedigree is quite large, you will soon hit the right hand edge of the displayed
pedigree tree.  When this happens, right-click on one of the goats in the pedigree and
choose the Display Pedigree for This Goat function.  That will have the effect of shifting
your "view" of the pedigree to the right so that you can enter more data.  When you get
that branch filled in, use the Return to Previous Pedigree button and choose another
goat farther down on the tree and repeat this process.  This is most easily done if you
choose goats in say the 2nd generation to shift the pedigree to the right.  There are four
of them and choosing them will let you enter two more generations of data which
means an additional 96 goats!

Backing Up Your Data

It won't be long before you have several thousand records entered in your database.
Eventually, the time will come when you have a hard disk crash, or the power goes off
and corrupts your file, or you make a mistake and delete one or more records that you
wanted to keep, or you accidentally delete the entire database file, or ...  It is not a
matter of if this will happen, it is only a matter of when.  When this does happen, you
do not want to lose all that data and the many hours you spent entering it.  The
solution is to make backups and to make them often.  Goat Pedigree 2000 has built in
capabilities to make this quick and easy.
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The program keeps track of how many records have been added or changed since the
last time you backed up your database.  Unless you turned off the automatic reminder
(not recommended), after the predetermined number of changes have been made, you
will be prompted to make a backup when you quit the program.  The threshold for this
prompt can be set in the General Preferences Option.  The first time you make a
backup, you will need to pick a folder where you want the file saved.  After you have
saved at least one backup, the program will remember where you put the last one and
will suggest that folder the next time.

I recommend that you keep three backups.  For example, you could name the backup
folders GoatBU1, GoatBU2, and GoatBU3.  Put your first backup in GoatBU1.  Put the
second in GoatBU2, and the third in GoatBU3.  When you save the fourth, put it in
GoatBU1, etc.  With this method, it is easy to know which folder to use: the program
will suggest the last one you used and you just "add 1" until you get to the last one
and then you go back to the first.

The reason for keeping more than one backup is safety.  First, it is not impossible that
one of your backup files could get corrupted somehow.  Second, if you make a mistake
and delete or incorrectly edit a bunch of records and don't realize this until after you
make a backup, you can recover from the next earlier backup and undo the mistake.
You will of course lose any changes or additions you made since the backup, but at
least you can get back to your previous known good database.

If you have more than one physical hard disk, I recommend that you keep your
backups on a disk other than the one where your database is located.  This will help
ensure the survival of your backup if you have a disk crash.

If you regularly backup your important files to tape or a CD, be sure to include your
current database and the backups saved by the program in your regular computer
backups.  If you want to backup the program settings you have established using the
Options menu, include the file GoatPed2000.INI in the folder where you installed the
program.


